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Preface

The Exploring Series and You
Exploring is Pearson’s Office Application series that requires students like you to think “beyond the 
point and click.” In this edition, the Exploring experience has evolved to be even more in tune with the 
student of  today. With an emphasis on Mac compatibility, critical thinking, and continual updates to 
stay in sync with the changing Microsoft Office 365, and by providing additional valuable assignments 
and resources, the Exploring series is able to offer you the most usable, current, and beneficial learning 
experience ever.

The goal of  Exploring is, as it has always been, to go farther than teaching just the steps to accomplish 
a task—the series provides the theoretical foundation for you to understand when and why to apply a 
skill. As a result, you achieve a deeper understanding of  each application and can apply this critical 
thinking beyond Office and the classroom.

New to This Edition
Continual eText Updates: This edition of  Exploring is written to Microsoft® Office 365®, which is con-
stantly updating. In order to stay current with the software, we are committed to twice annual updates 
of  the eText and Content Updates document available as an instructor resource for text users.

Focus on Mac: Mac usage is growing, and even outstripping PC usage at some four-year institutions. 
In response, new features such as Mac Tips, On a Mac step boxes, Mac Troubleshooting, and Mac tips on 
Student Reference Cards help ensure Mac users have a flawless experience using Exploring.

Expanded Running Case: In this edition, the Running Case has been expanded to all applications, 
with one exercise per chapter focusing on the New Castle County Technical Services case, providing a 
continuous and real-world project for students to work on throughout the semester.

Pre-Built Learning Modules: Pre-built inside MyLab IT, these make course setup a snap. The mod-
ules are based on research and instructor best practices, and can be easily customized to meet your 
course requirements.

Critical Thinking Modules: Pre-built inside MyLab IT, these pair a Grader Project with a critical 
thinking quiz that requires students to first complete a hands-on project, then reflect on what they did 
and the data or information they interacted with, to answer a series of  objective critical thinking ques-
tions. These are offered both at the chapter level for regular practice, as well as at the Application level 
where students can earn a Critical Thinking badge.

What’s New for MyLab IT Graders
Graders with WHY: All Grader project instructions now incorporate the scenario and the WHY to 
help students critically think and understand why they’re performing the steps in the project.

Hands-On Exercise Assessment Graders: A new Grader in each chapter that mirrors the Hands-On 
Exercise. Using an alternate scenario and data files, this new Grader is built to be more instructional 
and features Learning Aids such as Read (eText), Watch (video), and Practice (guided simulation) in the 
Grader report to help students learn, remediate, and resubmit.

Auto-Graded Critical Thinking Quizzes:

• Application Capstones that allow students to earn a Critical Thinking badge
• Chapter-level quizzes for each Mid-Level Exercise Grader project

Improved Mac Compatibility in Graders: All Graders are tested for Mac compatibility and any that 
can be made 100% Mac compatible are identified in the course. This excludes Access projects as well as 
any that use functionality not available in Mac Office.
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Autograded Integrated Grader Projects: Based on the discipline-specific integrated projects, cover-
ing Word, Excel, PowerPoint, and Access in various combinations.

Final Solution Image: Included with Grader student downloads, final output images allows students 
to visualize what their solution should look like.

What’s New for MyLab IT Simulations
Updated Office 365, 2019 Edition Simulations: Written by the Exploring author team, ensures 
one-to-one content to directly match the Hands-On Exercises (Simulation Training) and mirror them 
with an alternate scenario (Simulation Assessment).

Student Action Visualization: Provides a playback of  student actions within the simulation for 
remediation by students and review by instructors when there is a question about why an action is 
marked as incorrect.

Series Hallmarks
The How/Why Approach helps students move beyond the point and click to a true understanding of 
how to apply Microsoft Office skills.

• White Pages/Yellow Pages clearly distinguish the theory (white pages) from the skills covered in the 
Hands-On Exercises (yellow pages) so students always know what they are supposed to be doing and why.

• Case Study presents a scenario for the chapter, creating a story that ties the Hands-On Exercises 
together and gives context to the skills being introduced. 

• Hands-On Exercise Videos are tied to each Hands-On Exercise and walk students through the 
steps of  the exercise while weaving in conceptual information related to the Case Study and the 
objectives as a whole.

An Outcomes focus allows students and instructors to know the higher-level learning goals and how 
those are achieved through discreet objectives and skills.

• Outcomes presented at the beginning of  each chapter identify the learning goals for students and 
instructors.

• Enhanced Objective Mapping enables students to follow a directed path through each chapter, 
from the objectives list at the chapter opener through the exercises at the end of  the chapter.
• Objectives List: This provides a simple list of  key objectives covered in the chapter. This includes 

page numbers so students can skip between objectives where they feel they need the most help.
• Step Icons: These icons appear in the white pages and reference the step numbers in the Hands-

On Exercises, providing a correlation between the two so students can easily find conceptual help 
when they are working hands-on and need a refresher.

• Quick Concepts Check: A series of  questions that appear briefly at the end of  each white 
page section. These questions cover the most essential concepts in the white pages required for 
students to be successful in working the Hands-On Exercises. Page numbers are included for easy 
reference to help students locate the answers.

• Chapter Objectives Review: Located near the end of  the chapter and reviews all important 
concepts covered in the chapter. Designed in an easy-to-read bulleted format.

• MOS Certification Guide for instructors and students to direct anyone interested in prepping for 
the MOS exam to the specific locations to find all content required for the test.

End-of-Chapter Exercises offer instructors several options for assessment. Each chapter has 
approximately 11–12 exercises ranging from multiple choice questions to open-ended projects.

• Multiple Choice, Key Terms Matching, Practice Exercises, Mid-Level Exercises, Running 
Case, Disaster Recovery, and Capstone Exercises are at the end of  all chapters.
• Enhanced Mid-Level Exercises include a Creative Case (for PowerPoint and Word), which 

allows students some flexibility and creativity, not being bound by a definitive solution, and an 
Analysis Case (for Excel and Access), which requires students to interpret the data they are 
using to answer an analytic question.

• Application Capstone exercises are included in the book to allow instructors to test students on 
the contents of  a single application.
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The Exploring Series and MyLab IT
The Exploring Series has been a market leader for more than 20 years, with a hallmark focus on both the 
how and why behind what students do within the Microsoft Office software. In this edition, the pairing of  
the text with MyLab IT Simulations, Graders, Objective Quizzes, and Resources as a fully complementary 
program allows students and instructors to get the very most out of  their use of  the Exploring Series.

To maximize student results, we recommend pairing the text content with MyLab IT, which is the teach-
ing and learning platform that empowers you to reach every student. By combining trusted author 
content with digital tools and a flexible platform, MyLab personalizes the learning experience and helps 
your students learn and retain key course concepts while developing skills that future employers are 
seeking in their candidates.

Solving Teaching and Learning 
Challenges
Pearson addresses these teaching and learning challenges with Exploring and MyLab IT 2019.

Reach Every Student
MyLab IT 2019 delivers trusted content and resources through easy-to-use, Prebuilt Learning Modules 
that promote student success. Through an authentic learning experience, students become sharp 
critical thinkers and proficient in Microsoft Office, developing essential skills employers seek.

Practice and Feedback: What do I do when I 
get stuck or need more practice?
MyLab IT features Integrated Learning Aids within the Simulations and now also within the Grader 
Reports, allowing students to choose to Read (via the eText), Watch (via an author-created hands-on 
video), or Practice (via a guided simulation) whenever they get stuck. These are conveniently accessible 
directly within the simulation training so that students do not have to leave the graded assignment to 
access these helpful resources. The Student Action Visualization captures all the work students do 
in the Simulation for both Training and Assessment and allows students and instructors to watch a 
detailed playback for the purpose of  remediation or guidance when students get stuck. MyLab IT offers 
Grader project reports for coaching, remediation, and defensible grading. Score Card Detail allows 
you to easily see where students were scored correctly or incorrectly, pointing out how many points 
were deducted on each step. Live Comments Report allows you and the students to see the actual files 
the student submitted with mark-ups/comments on what they missed and now includes Learning Aids 
to provide immediate remediation for incorrect steps.

Application, Motivation, and Employability 
Skills: Why am I taking this course, and will this 
help me get a job?
Students want to know that what they are doing in this class is setting them up for their ultimate 
goal—to get a job. With an emphasis on employability skills like critical thinking and other soft 
skills, digital badges to prove student proficiency in Microsoft skills and critical thinking, and MOS 
Certification practice materials in MyLab IT, the Exploring Series is putting students on the path to 
differentiate themselves in the job market, so that they can find and land a job that values their schools 
once they leave school.
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Application: How do I get students to apply 
what they’ve learned in a meaningful way?
The Exploring Series and MyLab IT offer instructors the ability to provide students with authentic forma-
tive and summative assessments. The realistic and hi-fidelity simulations help students feel like they 
are working in the real Microsoft applications and allow them to explore, use 96% of  Microsoft methods, 
and do so without penalty. The Grader projects allow students to gain real-world context as they work 
live in the application, applying both an understanding of  how and why to perform certain skills to com-
plete a project. New Critical Thinking quizzes require students to demonstrate their understanding 
of  why, by answering questions that force them to analyze and interpret the project they worked on to 
answer a series of  objective questions. The new Running Case woven through all applications requires 
students to apply their knowledge in a realistic way to a long-running, semester-long project focused 
on the same company.

Ease of Use: I need a course solution that is 
easy to use for both me and my students
MyLab IT 2019 is the easiest and most accessible in its history. With new Prebuilt Learning and 
Critical Thinking Modules course set-up is simple! LMS integration capabilities allow users 
seamless access to MyLab IT with single sign-on, grade sync, and asset-level deep linking. Continuing 
a focus on accessibility, MyLab IT includes an integrated Accessibility Toolbar with translation 
feature for students with disabilities, as well as a Virtual Keyboard that allows students to complete 
keyboard actions entirely on screen. There is also an enhanced focus on Mac compatibility with even 
more Mac-compatible Grader projects,

Developing Employability Skills
High-Demand Office Skills are taught to help students gain these skills and prepare for the Microsoft 
Office Certification exams (MOS). The MOS objectives are covered throughout the content, and a MOS 
Objective Appendix provides clear mapping of  where to find each objective. Practice exams in the form 
of  Graders and Simulations are available in MyLab IT.

Badging Digital badges are available for students in Introductory and Advanced Microsoft Word, 
Excel, Access, and PowerPoint. This digital credential is issued to students upon successful completion 
(90%+ score) of  an Application Capstone Badging Grader project. MyLab IT badges provide verified evi-
dence that learners have demonstrated specific skills and competencies using Microsoft Office tools in 
a real project and help distinguish students within the job pool. Badges are issued through the Acclaim 
 system and can be placed in a LinkedIn ePortfolio, posted on social media (Facebook, Twitter), and/or 
included in a résumé. Badges include tags with relevant information that allow students to be discover-
able by potential employers, as well as search for jobs for which they are qualified.

“The badge is a way for employers to actually verify that a potential employee is actually 
somewhat fluent with Excel.”—Bunker Hill Community College Student

The new Critical Thinking Badge in MyLab IT for 2019 provides verified evidence that learners have 
demonstrated the ability to not only complete a real project, but also analyze and problem-solve using 
Microsoft Office applications. Students prove this by completing an objective quiz that requires them to 
critically think about the project, interpret data, and explain why they performed the actions they did 
in the project. Critical Thinking is a hot button issue at many institutions and is highly sought after in 
job candidates, allowing students with the Critical Thinking Badge to stand out and prove their skills.

Soft Skills Videos are included in MyLab IT for educators who want to emphasize key employability 
skills such as Accepting Criticism and Being Coachable, Customer Service, and Resume and Cover 
Letter Best Practices.
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Resources
Instructor Teaching Resources
Supplements Available  
to Instructors at  
www.pearsonhighered.com/ 
exploring Features of the Supplement

Instructor’s Manual Available for each chapter and includes:

• List of all Chapter Resources, File Names, and Where to Find
• Chapter Overview
• Class Run-Down
• Key Terms
• Discussion Questions
• Practice Projects & Applications
• Teaching Notes
• Additional Web Resources
• Projects and Exercises with File Names
• Solutions to Multiple Choice, Key Terms Matching, and Quick 

Concepts Checks

Solutions Files, Annotated 
Solution Files, Scorecards

• Available for all exercises with definitive solutions
• Annotated Solution Files in PDF feature callouts to enable 

easy grading
• Scorecards to allow for easy scoring for hand-grading all 

 exercises with definitive solutions, and scoring by step adding 
to 100 points. 

Rubrics For Mid-Level Exercises without a definitive solution. Available 
in Microsoft Word format, enabling instructors to customize the 
assignments for their classes

Test Bank Approximately 75–100 total questions per chapter, made up of 
multiple-choice, true/false, and matching.

Questions include these annotations:

• Correct Answer
• Difficulty Level
• Learning Objective

Alternative versions of the Test Bank are available for the 
following LMS: Blackboard CE/Vista, Blackboard, Desire2Learn, 
Moodle, Sakai, and Canvas

Computerized TestGen TestGen allows instructors to:

• Customize, save, and generate classroom tests
• Edit, add, or delete questions from the Test Item Files
• Analyze test results
• Organize a database of tests and student results

PowerPoint Presentations PowerPoints for each chapter cover key topics, feature key 
images from the text, and include detailed speaker notes in 
addition to the slide content.

PowerPoints meet accessibility standards for students with 
disabilities. Features include, but are not limited to:

• Keyboard and Screen Reader access
• Alternative text for images
• High color contrast between background and foreground 

colors

www.pearsonhighered.com/exploring
www.pearsonhighered.com/exploring
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Scripted Lectures • A lecture guide that provides the actions and language to help 
demonstrate skills from the chapter

• Follows the activity similar to the Hands-On Exercises but 
with an alternative scenario and data files

Prepared Exams • An optional Hands-On Exercise that can be used to assess 
students’ ability to perform the skills from each chapter, or 
across all chapters in an application.

• Each Prepared Exam folder includes the needed data files, 
instruction file, solution, annotated solution, and scorecard.

Outcome and Objective Maps • Available for each chapter to help you determine what to 
assign

• Includes every exercise and identifies which outcomes, 
 objectives, and skills are included from the chapter

MOS Mapping, MOS Online 
Appendix

• Based on the Office 2019 MOS Objectives
• Includes a full mapping of where each objective is covered in 

the materials
• For any content not covered in the textbook, additional 

 material is available in the Online Appendix document

Transition Guide A detailed spreadsheet that provides a clear mapping of content 
from Exploring Microsoft Office 2016 to Exploring Microsoft 
Office 365, 2019 Edition

Content Updates Guide A living document that features any changes in content based on 
Microsoft Office 365 changes as well as any errata

Assignment Sheets Document with a grid of suggested student deliverables per 
chapter that can be passed out to students with columns for 
Due Date, Possible Points, and Actual Points

Sample Syllabus Syllabus templates set up for 8-week, 12-week, and 16-week 
courses

Answer Keys for Multiple 
Choice, Key Terms Matching, 
and Quick Concepts Check

Answer keys for each objective, matching, or short-answer 
question type from each chapter

Student Resources
Supplements Available  
to Students at  
www.pearsonhighered.com/ 
exploring Features of the Supplement

Student Data Files All data files needed for the following exercises, organized by 
chapter:

• Hands-On Exercises
• Practice Exercises
• Mid-Level Exercises
• Running Case
• Disaster Recovery Case
• Capstone Exercise

MOS Certification Material • Based on the Office 2019 MOS Objectives
• Includes a full mapping of where each objective is covered in 

the materials
• For any content not covered in the textbook,  additional 

 material is available in the Online  Appendix document

www.pearsonhighered.com/exploring
www.pearsonhighered.com/exploring
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COMPREHENSIVE

(ex•ploring)
1. Investigating in a systematic way: examining. 2. Searching into 
or ranging over for the purpose of  discovery.
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OBJECTIVES & SKILLS: After you read this chapter, you will be able to:

CASE STUDY | Spotted Begonia Art Gallery
You are an administrative assistant for Spotted Begonia, a local art gallery. The gallery does a lot of 
community outreach to help local artists develop a network of clients and supporters. Local schools are 
invited to bring students to the gallery for enrichment programs.

As the administrative assistant for Spotted Begonia, you are responsible for overseeing the production 
of documents, spreadsheets, newspaper articles, and presentations that will be used to increase public 
awareness of the gallery. Other clerical assistants who are familiar with Microsoft Office will prepare 
the promotional materials, and you will proofread, make necessary corrections, adjust page layouts, 
save and print documents, and identify appropriate templates to simplify tasks. Your experience with 
Microsoft Office is limited, but you know that certain fundamental tasks that are common to Word, 
Excel, and PowerPoint will help you accomplish your oversight task. You are excited to get started with 
your work!

You will apply skills common across the Microsoft Office suite to create and format 
documents and edit content in Office 365 applications.

LEARNING 
OUTCOME

Get Started with Office Applications

OBJECTIVE 1: START AN OFFICE APPLICATION  5
Use Your Microsoft Account, Use OneDrive

OBJECTIVE 2: WORK WITH FILES  6
Create a New File, Save a File, Open a Saved File

OBJECTIVE 3: USE COMMON INTERFACE COMPONENTS  9
Use the Ribbon, Use a Dialog Box and Gallery,  
Customize the Ribbon, Use the Quick Access Toolbar, 
Customize the Quick Access Toolbar, Use a Shortcut  
Menu, Use Keyboard Shortcuts

OBJECTIVE 4: GET HELP  15
Use the Tell Me Box, Use the Help Tab, Use Enhanced 
ScreenTips

OBJECTIVE 5: INSTALL ADD-INS  17
Use an Add-in from the Store

HANDS-ON EXERCISE 1  19

Format Document Content

OBJECTIVE 6: USE TEMPLATES AND APPLY THEMES  25
Open a Template, Apply a Theme

OBJECTIVE 7: MODIFY TEXT  27
Select Text, Format Text, Use the Mini Toolbar

OBJECTIVE 8: RELOCATE TEXT  30
Cut, Copy, and Paste Text; Use the Office Clipboard

OBJECTIVE 9: REVIEW A DOCUMENT  32
Check Spelling and Grammar

OBJECTIVE 10: WORK WITH PICTURES  34
Insert a Picture, Modify a Picture

HANDS-ON EXERCISE 2 37

  

Modify Document Layout and Properties

OBJECTIVE 11: CHANGE DOCUMENT VIEWS  45
Change Document Views Using the Ribbon,  
Change Document Views Using the Status Bar

OBJECTIVE 12: CHANGE THE PAGE LAYOUT  46
Change Margins, Change Page Orientation,  
Use the Page Setup Dialog Box

OBJECTIVE 13: CREATE A HEADER AND FOOTER  49
Insert a Footer, Insert a Header

OBJECTIVE 14: CONFIGURE DOCUMENT PROPERTIES  50
View and Enter Document Properties

OBJECTIVE 15: PREVIEW AND PRINT A FILE  51
Preview a File, Change Print Settings, Print a File

HANDS-ON EXERCISE 3 53

  

Office 365  
Common Features

Common 
Features
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CASE STUDY | Spotted Begonia Art Gallery

Starting Files Files to be Submitted

cf01h1Letter.docx
Seasonal Event Flyer Template

cf01h1Letter_LastFirst.docx
cf01h3Flyer_LastFirst.docx

FIGURE 1.1 Spotted Begonia Art Gallery Documents

MyLab IT Grader  An alternate version of this project is available as a MyLab IT Grader Assessment
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Get Started with Office 
Applications
Organizations around the world rely heavily on Microsoft Office software to produce 
documents, spreadsheets, presentations, and databases. Microsoft Office is a productivity 
software suite that includes a set of  software applications, each one specializing in a 
specific type of  output. There are different versions of  Office. Office 365 is purchased as a 
monthly or annual subscription and is fully installed on your PC, tablet, and phone. With 
Office 365, you receive periodic updates of  new features and security measures. Office 
365 also includes access to OneDrive storage. Office 2019 is a one-time purchase and fully 
installed on your PC. Periodic upgrades are not available. Both Office 365 and Office 2019 
have versions that run on a Mac.

All versions of  Microsoft Office include Word, Excel, and PowerPoint, as well as some 
other applications. Some versions of  Office also include Access. Office 365 for Mac and 
Office for Mac include Word, Excel, and PowerPoint, but not Access. Microsoft Word (Word) 
is a word processing application, used to produce all sorts of  documents, including memos, 
newsletters, reports, and brochures. Microsoft Excel (Excel) is a financial spreadsheet 
program, used to organize records, financial transactions, and business information in the 
form of  worksheets. Microsoft PowerPoint (PowerPoint) is presentation software, used to 
create dynamic presentations to inform and persuade audiences. Finally, Microsoft Access 
(Access) is a database program, used to record and link data, query databases, and create 
forms and reports. The choice of  which software application to use really depends on what 
type of  output you are producing. Table 1.1 describes the major tasks of  the four primary 
applications in Microsoft Office.

TABLE 1.1 Microsoft Office Applications
Office Application Application Characteristics

Word
Word processing software used with text and graphics to create, edit, and 
format documents.

Excel
Spreadsheet software used to store quantitative data and to perform 
accurate and rapid calculations, what-if analyses, and charting, with results 
ranging from simple budgets to sophisticated financial and statistical analyses.

PowerPoint
Presentation graphics software used to create slide shows for presentation 
by a speaker or delivered online, to be published as part of a website, or to 
run as a stand-alone application on a computer kiosk.

Access

Relational database software used to store data and convert it into 
information. Database software is used primarily for decision making by 
businesses that compile data from multiple records stored in tables to 
produce informative reports.

These programs are designed to work together, so you can integrate components 
created in one application into a file created by another application. For example, you could 
integrate a chart created in Excel into a Word document or a PowerPoint presentation, or 
you could export a table created in Access into Excel for further analysis. You can use two 
or more Office applications to produce your intended output.

In addition, Microsoft Office applications share common features. Such commonality 
gives a similar feel to each software application so that learning and working with each 
Office software application is easier. This chapter focuses on many common features 
that the Office applications share. Although Word is primarily used to illustrate many 
examples, you are encouraged to open and explore Excel and PowerPoint (and to some 
degree, Access) to examine the same features in those applications. As a note, most of   
the content in this chapter and book are for the Windows-based Office applications. Some 
basic information about Office for Mac is included in TIP boxes and in the Step boxes when 
there are significant differences to point out.
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In this section, you will learn how to log in with your Microsoft account, open an 
application, and open and save a file. You will also learn to identify interface components 
common to Office software applications, such as the ribbon, Backstage view, and the Quick 
Access Toolbar. You will experience Live Preview. You will learn how to get help with an 
application. You will also learn about customizing the ribbon and using Office add-ins.

Starting an Office Application
Microsoft Office applications are launched from the Start menu. Select the Start icon   
to display the Start menu and select the app tile for the application in which you want 
to work (see Figure 1.2). Note: The Start menu in Figure 1.2 may show different tiles 
and arrangement of  tiles than what is on your Start menu. If  the application tile you 
want is not on the Start menu, you can open the program from the list of  all apps on 
the left side of  the Start menu, or alternatively, you can use search on the taskbar. Just 
type the name of  the program in the search box and press Enter. The program will open 
automatically.

FIGURE 1.2 Windows Start Menu

Start icon

Microsoft Office application tiles
List of applications

Search box Taskbar

Use Your Microsoft Account
When you have a Microsoft account, you can sign in to any Windows computer and you 
will be able to access the saved settings associated with your Microsoft account. That 
means any computer can have the same familiar look that you are used to seeing on your 
home or school computers and devices. Your Microsoft account will automatically sign in 
to all the apps and services that use a Microsoft account, such as OneDrive and Outlook. 
If  you share your computer with another user, each user can have access to his or her 
own Microsoft account, and can easily switch between accounts by logging out of  one 
Microsoft account and logging in to another Microsoft account. You can switch accounts 
within an application as well.
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Use OneDrive
Having a Microsoft account also provides additional benefits, such as being connected 
to all of  Microsoft’s resources on the Internet. These resources include an Outlook email 
account and access to OneDrive cloud storage. Cloud storage is a technology used to store 
files and work with programs that are stored in a central location on the Internet. OneDrive 
is a Microsoft app used to store, access, and share files and folders on the Internet. OneDrive 
is the default storage location when saving Office files. Because OneDrive stores files on 
the Internet, when a document has been saved in OneDrive the most recent version of  the 
document will be accessible when you log in from any computer connected to the Internet. 
Files and folders saved to OneDrive can be available offline and accessed through File 
Explorer—Windows’ file management system. Moreover, changes made to any document 
saved to OneDrive will be automatically updated across all devices, so each device you 
access with your Windows account will all have the same version of  the file.

OneDrive enables you to collaborate with others. You can share your documents with 
others or edit a document on which you are collaborating. You can even work with others 
simultaneously on the same document.

Working with Files
When working with an Office application, you can begin by opening an existing file 
that has already been saved to a storage medium or you can begin work on a new file or 
template. When you are finished with a file, you should save it, so you can retrieve it at 
another time.

Create a New File
After opening an Office application, you will be presented with template choices. Use the Blank 
document (workbook, presentation, database, etc.) template to start a new blank file. You can 
also create a new Office file from within an application by selecting New from the File tab.

The File tab is located at the far left of  the ribbon. When you select the File tab, you 
see Backstage view. Backstage view is where you manage your files and the data about 
them—creating, saving, printing, sharing, inspecting for accessibility, compatibility, and 
other document issues, and accessing other setting options. The File tab and Backstage 
view is where you do things “to” a file, whereas the other tabs on the ribbon enable you 
to do things “in” a file.

STEP 1

On a Mac, to switch between accounts in an application, complete the 
following steps:

1. Click the application menu (Word, Excel, etc.), click Sign Out, and then click Sign Out 
again.

2. Click File, click New From Template, and then click Sign in at top of  the left pane.
3. Click Sign in again, type your user email, click Next, type password, and then click 

Sign in.

To switch between accounts in an application such as Word, complete the 
following steps:

1. Click the profile name at the top-right of  the application.
2. Select Switch account.
3. Select an account from the list, if  the account has already been added to the computer, 

or add a new account.
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FIGURE 1.3 Save As in Backstage View
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Save a File
Saving a file enables you to open it for additional updates or reference later. Files are saved 
to a storage medium such as a hard drive, flash drive, or to OneDrive.

The first time you save a file, you indicate where the file will be saved and assign a 
file name. It is best to save the file in an appropriately named folder so you can find it 
easily later. Thereafter, you can continue to save the file with the same name and location 
using the Save command. If  the file is saved in OneDrive, any changes to the file will be 
automatically saved. You do not have to actively save the document. If  you want more 
control over when changes to your document are saved, you have the option to turn this 
feature off  (or back on) with the AutoSave feature in the Quick Access Toolbar.

There are instances where you will want to rename the file or save it to a different 
location. For example, you might reuse a budget saved as an Excel worksheet, modifying it for 
another year, and want to keep a copy of  both the old and revised budgets. In this instance, 
you would save the new workbook with a new name, and perhaps save it in a different folder. 
To do so, use the Save As command, and continue with the same procedure to save a new 
file: navigating to the new storage location and changing the file name. Figure 1.3 shows a 
typical Save As pane that enables you to select a location before saving the file. Notice that 
OneDrive is listed as well as This PC. To navigate to a specific location, use Browse.

To save a file with a different name and/or file location, complete the 
following steps:

1. Click the File tab.
2. Click Save As.
3. Select a location or click Browse to navigate to the file storage location.
4. Type the file name.
5. Click Save.

STEP 2 Open a Saved File
Often you will need to work on an existing file that has been saved to a storage location. 
This may be an email attachment that you have downloaded to a storage device, a file that 
has been shared with you in OneDrive, or a file you have previously created. To open an 
existing file, navigate in File Explorer to the folder or drive where the document is stored, 
and then double-click the file name to open the file. The application and the file will open. 
Alternatively, if  the application is already open, from Backstage view, click Open, and then 
click Browse, This PC, or OneDrive to locate and open the file (see Figure 1.4).

MAC TIP: To open an existing file, navigate in Finder to the folder or drive where the document is 
stored and double-click the file name to open the file.
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FIGURE 1.5 Recent Documents List
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FIGURE 1.4 Open in Backstage View
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Office simplifies the task of  reopening files by providing a Recent documents list 
with links to your most recently used files, as shown in Figure 1.5. When opening the 
application, the Recent list displays in the center pane. The Recent list changes to reflect 
only the most recently opened files, so if  it has been quite some time since you worked 
with a particular file, or if  you have worked on several other files in between and you do 
not see your file listed, you can click More documents (or Workbooks, Presentations, etc).
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Using Common Interface Components
When you open any Office application, you will first notice the title bar and ribbon 
(see Figure 1.6) at the top of  the document. These features enable you to identify the 
document, provide easy access to frequently used commands, and controls the window 
in which the document displays. The title bar identifies the current file name and the 
application in which you are working. It also includes control buttons that enable you 
to minimize, restore down, or close the application window. The Quick Access Toolbar, 
on the left side of  the title bar, enables you to turn AutoSave on or off, save the file, undo 
or redo editing, and customize the Quick Access Toolbar. Located just below the title bar 
is the ribbon. The ribbon is the command center of  Office applications containing tabs, 
groups, and commands. If  you are working with a large project, you can maximize your 
workspace by temporarily hiding the ribbon. There are several methods that can be used 
to hide and then redisplay the ribbon:

• Double-click any tab name to collapse; click any tab name to expand

• Click the Collapse Ribbon arrow at the far-right side of  the ribbon

• Use the Ribbon Display Option on the right side of  the Title bar. These controls 
enable you to not only collapse or expand the ribbon, but also to choose whether 
you want to see the tabs or no tabs at all.

TIP: KEEPING FILES ON THE RECENT DOCUMENTS LIST
The Recent list displays a limited list of  only the most recently opened files. However, you might want 
to keep a particular file in the list regardless of  how recently it was opened. In Figure 1.5, note that the 
Pin this item to the list icon  displays to the right of  each file. Select the icon to pin the file to the list. 
The pushpin of  the “permanent” file will change direction so that it appears to be inserted, indicating 
that it is a pinned item. Once pinned, you will always have access to the file from the Pinned list. Later, 
if  you want to remove the file from the list, click the pushpin icon. The file will remain on the Recent 
documents list while it is being used, but will be bumped off  the list when other, more recently opened 
files take its place.

FIGURE 1.6 The Title Bar, Quick Access Toolbar, and Document Controls
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Use the Ribbon
The main organizational grouping on the ribbon is tabs. The tab name indicates the type 
of  commands located on the tab. On each tab, the ribbon displays several task-oriented 
groups. A group is a subset of  a tab that organizes similar commands together. A command 
is a button or task within a group that you select to perform a task (see Figure 1.7).  
The ribbon with the tabs and groups of  commands is designed to provide efficient 
functionality. For that reason, the Home tab displays when you first open a file in an Office 
software application and contains groups with the most commonly used commands for 
that application. For example, because you often want to change the way text is displayed, 
the Home tab in an Office application includes a Font group, with commands related to 




